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3 reasons to like dynamic input 

As you know, dynamic input provides a command interface near the cursor to help you keep your focus in the drafting area. When 

dynamic input is on, tooltips display information near the cursor that is dynamically updated as the cursor moves. When a 

command is active, the tooltips provide a place for user entry and there are command options which are more intuitive and 

convenience to select. Here there are 3 reasons to like dynamic input: 

1. Get command faster:  

With dynamic input you will save time typing and finding out whatever longer or shorter command name rather than using the 

command line or selecting a command at toolbars! What’s more, dynamic input can auto complete the command name at once. 

When type a command using the dynamic input, it displays a list of all the commands whose prefix matches what you've typed 

plus it will displays all their icons making easier to recognize them at glance.  

 

 

 

 

 

2. Flexible methods to select a command option 

1
st
. Method: After entering a command just type the CAPITAL letter of the option to be selected and press ENTER. Then the tooltip 

will prompt the command message. 

 

 

 

 

Interface 
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2
nd

. Method: After entering a command just use the arrow keys (Up/Down) to cycle select the option and press ENTER. Notice 

while selecting any option, this will be dot highlighted.  

Under the same method, after pressing the right arrow key, users can select an option using the cursor as they like. Notice when 

hovering the cursor over an option, it will be color highlighted. 

3. Customized dynamic input options 

Within Drafting Settings dialog box, under Dynamic 

Input tab, there is an option called Show Dynamic 

Input Tooltip near the crosshairs. By default, this 

option is checked, but if you uncheck it, when 

executing a command, the dynamic input tooltip will 

be fixed and away from the crosshair. 

 

When the dynamic input tooltip is fixed, it turns semi-transparent as default. At this stage you can freely move the cursor over the 

workspace but when you move it over the dynamic input, it will be highlighted. What’s more, you can select a command option 

with the cursor.  

If you already select the option Show Dynamic Input Tooltip 

near the crosshairs, you can drag with the cursor, the dynamic 

input tooltip to anywhere around workspace. When dynamic 

input is dragged, it turns highlight. 

 

Within Drafting Settings dialog box, under Dynamic Input tab, 

there is an option called Automatically Enter when the keyword is Matched.  This option allows to typing the CAPITAL letter of the 

command option to be selected. After typed, you don’t need to press ENTER. The option will be executed automatically. With this 

option ,your drafting design efficiency can be enhanced greatly. 

 

 

How to cycle commands? 

As a new or experience CAD user, you might found that GstarCAD has a lot of commands. Not to mention changing the system 

variables. Some (well, many…) of them have to be activated from command line. 

It is very difficult to remember all of them. Even for experienced users. Don’t worry, you can just type first one or two characters, 

and cycle between those commands! 

http://www.cadforum.cz/cadforum_en/command.asp
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For example, type two characters like ‘re’ to find out what commands started with them. Then press down arrow, keep pressing for 

several times. You will see the commands cycling in dynamic input. 

 

 

 

How to perform transparent commands? 

You can use many commands transparently like pan, zoom, setvar, about, help, OSNAP, CAL, color, etc. You can enter them on 

the command line while another command is active. To use a command transparently, enter an apostrophe (') before entering the 

command. After you complete the transparent command, the original command resumes. Example: 

 

Command: L 

LINE Specify first point: 'p 

>>Press ESC or ENTER to exit, or right-click to display shortcut menu. 

Resuming LINE command. 

Specify first point:   

 

How to change zoom speed? 

Have you ever felt like the middle mouse wheel 

zoom is too fast or too slow when drawing? It can 

depend on the scale of the drawing and objects 

you are working on, or perhaps even your mood. 

This speed of the zoom in and out is controlled by 

a system variable named ZOOMFACTOR. The 

default of the system variable ZOOMFACTOR is 

http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/index.html?url=WS1a9193826455f5ff-5187222b11eeadcdc61-56ff.htm,topicNumber=d0e188116
http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/files/WSfacf1429558a55de1a7524c1004e616f8b-64f4.htm
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60. You type ZOOMFACTOR and then change the value.  

This is another one of those little settings that allow you to make GstarCAD more tailored to your use whether you like warp speed 

zooms or turtle slow zooming with the mouse wheel.  

How to change zoom direction? 

Another related system variable is ZOOMWHEEL which can toggles the direction of transparent zoom operations when you scroll 

the middle mouse wheel. 

0 Moves wheel forward zooms in; moving wheel backwards zooms out. 

 

 

 

 

 

 

 

1 Move wheel forward zooms out; moving wheel backwards zooms in. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.autodesk.com/autocad
http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/files/WS1a9193826455f5ffa23ce210c4a30acaf-4db2.htm
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How do I pack my files with eTransmit? 

Do you often need to send your drawing files to your 

customers? But quite often they have troubles to see all 

drawing resource attached like reference paths broken, or 

don’t include the plot style table, custom fonts, etc. There 

is a tool that can be very useful for these 

situations: eTransmit will pack your related files into a 

transmittal package. Includes your reference files, plot style 

table, reorganize your reference path, material textures, data 

link files, etc. You can open eTransmit by accessing 

GstarCAD menu: File>eTransmit. 

 Click Transmittal setup and click modify. You’ll see a lot of option that you can use. You can change path option, so all your files 

will be included in one folder. So you don’t have to worry your path will be broken. 

 

 

 

 

 

 

 

 

Or you can simply bind it all to a master file. Some cad users are not familiar with external reference, so sometimes bind them all 

in master file can be a good idea. You can also choose what types of file to be included. Sometimes you don’t want your partner to 

have excel file in data links. Or maybe they already share same fonts or material textures. If you will send this file to your partner 

using old version of GstarCAD, you can choose to convert it all first. 

Share & File options 

http://cad-notes.com/2010/10/quick-and-dirty-tip-resolving-autocad-xref-path/
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How to set a previous file version as default? 

Do you have to work with different drawing versions? Or maybe you mostly have to send your DWG files in older file format? You 

can set to save the files to older file format version, by default. 

You can access it in option dialog box, in open and save tab, under File Save option. Also, in the Save drawing as dialog box, 

select options and change the default to the lowest file format the other users can open it. Now you don’t have to worry the others 

can’t open your GstarCAD files! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 ways to modify block definition  

Block is very useful as reusable contents. And when you need to create 

similar objects in your drawing. One of the most popular benefits is when you 

need to modify all instances; you only need to modify one. All other instance 

will be automatically updated. We will see 3 methods that you can use to 

modify your block definition. 

Block 
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1. Explode and recreate the block: 

Long time ago, the only way to edit a block was by exploding it to simpler objects through EXPLODE command. Made any 

changes necessary, then recreate a block with the same name. This method has become obsolete but reliable if you are still using 

old CAD versions. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Edit block in-place:  

Edit block in-place is a great way to modify block when you want to use other 

objects in the drawing as reference. The tool we use is actually REFEDIT. It 

was originally for reference editing, but works for blocks too. You can activate 

this by selecting a block, right click then choose edit block in-place from 

context menu. Or by using REFEDIT command. 

This tool is not block editor. So don’t expect you will see specific block 

editing tools like in block editor. You can add or remove objects to your 

block. 
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3. Using block editor:  

Block editor is a very powerful tool to edit your block. Not only allow you to modify your block geometry, you can also create a 

dynamic block here. You can activate block editor in different ways by double clicking a block OR select a block then right click 

mouse> choose block editor from context menu. You can also choose from GstarCAD ribbon> Insert tab>Block definition 

panel>Block editor OR go to tools tab at menu bar and choose> block editor. 

 

 

 

 

 

 

 

 

One thing you must remember. When working with block editor, 0,0 is the insertion point. So don’t move the geometry unless you 

want to move the insertion point! 

 

 

 

 

 

 

 

 

 

 

How to duplicate block definition? 

When we want to create a similar block from existing block, how do you do it? Explode it and recreate block with different name? 

You will have a lot of problem when you have block with many dynamic block parameters and actions! In dynamic block editor, we 

can save the block as different name. Yes, there is ‘save block as’ tool in open/save panel! 
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How to add descriptions to blocks? 

GstarCAD has the ability to add descriptions to the block definitions in the drawing. 

1. Issue the BLOCK command. 

2. Select the block from the list at top. 

3. Click in the lower 'Description' section and enter the description. 

4. Choose OK to redefine the block with the new description. 

 

 

 

 

 

                                                                                                                                    

 How do I control the prompt order for attributes? 

When building the block definition, the selection order is the key. If you simply window off the geometry there is a good possibility 

the prompt order will not be as desired.   

 

 

 



 

17 

 

When selecting objects for a block definition, first individually pick the attribute definitions individually in the order you want to be 

prompted, then select the rest of the geometry. 

   

 

 

 

 

How to maintain the attributes value when exploding? 

Block attributes is a nice tool to have. We can use it to preserve text style and size as annotation block. Drawing title and title block 

is a good example. The problem is when we need it explode it somehow, we will lose any information we put in the attribute. To 

preserve the values, do not use explode command, use BURST instead. 

 

  

 

 

 

General Steps of Creating a Dynamic Block Definition 

In order to get a Dynamic Block Definition, improve block editing efficiency and avoid repeating modifications, we can create 

Dynamic Block by the following steps. 

Step1: Planning: 

Before creating Dynamic Block, it is essential to plan Dynamic Block, plan the functions, appearance, the method of drawing and 

required Parameter(s) and Action(s) which are needed to achieve prospective functions. 

Step2: Draw geometric figure: 

The included basic pixel during Dynamic drawing, of course you can draw these pixel in Block Editor. 

Step3: Add Parameter and Action: 

This is the most pivotal step when creating Dynamic Block. When editing the Parameter and Action, you not only consider the 

achievement of Parameter and Action, but also consider the readability of Dynamic Block and the convenience of Modification, let 
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the action point of the Parameter attach on the corresponding pixel as far as possible, and put the Action near to its relevant 

parameter, if there are more Parameters and Actions, they still need to be renamed for understanding, editing and Modification. 

Step4: Test Dynamic Block 

Save and Exit Block Editor, start the Dynamic Block test to check if it reaches to the prospective effect. 

 

Dynamic Block Creation (Visibility)                                                                                                

Using the Visibility Parameter function, you can control the display and hide a certain view in Dynamic Block. 

1. Prepare view:  

Draw three cars as below and define all of them as block. 

 

 

 

 

2. Add Parameter of Visibility:  

Enter into Block Editor by Double-clicking the block or right- click the menu, click the button Visibility of Parameter in the 

Parameter panel, appoint the position of the Parameter according to the system prompt, as shown below. 
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3. Edit Visibility States:  

Click the visibility states button, then the Visibility States dialog box will be 

displayed. In the dialog box, you can rename, create new and remove Visibility 

States. In order to control the visibility of the three cars view in this example, we 

click new option for the three Visibility States as shown in the picture. 

 Click the following button as shown in the picture and choose roadster in the pull 

down menu. 

Click the “Invisibility” button in the Visibility tool panel, select truck and car drawings, then make 

them invisible in the “roadster” state, as shown in the following picture, after selecting, press enter to 

confirm. For the state of “Car” and “Truck”, set them in the same way. 

 

 

 

 

 

 

4. Move and Adjust: 

After finishing the editing of the Visibility States, move the three cars view to make them overlap each other as shown in the 

picture bellow. 

 

 

 

5. Test Dynamic Block:  

Insert the Dynamic Block into a drawing, select Dynamic Block and click the grip of Visibility Parameter, choose one item in the 

pull-down list, Dynamic Block will change the display state automatically, as shown in the following picture. 
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Dynamic Block Creation (Alignment)                                                                                                

Alignment Parameter can give dynamic blocks the function of alignment automatically, which can save the step of rotating the 

blocks. 

1. Add an Alignment Parameter for a Roughness Symbol:  

Draw a roughness symbol in the Block Editor. Select the icon of the alignment parameter. Specify the location and the aligned 

orientation of the parameter following what the computer asked as shown in the picture, the dotted line is the align orientation. 

 

 

 

2. Test Dynamic Block:  

Insert the roughness dynamic blocks, move the align grips, the symbol will align with the interface of the dimensions, as shown in 

the picture below. 
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Dynamic Block Creation (Flip)                                                                                                

When you use the "roughness symbol block" to label the spare parts, the symbol is sometimes already in the right position, 

however, the characters' direction is not right. We need to add the "character flip" function to receive the correct label. 

1. Add Flip Parameter:  

Click the "flip" parameter button; add the flip parameter according to prompt, 

as shown in the picture. 

 

 

2. Add Flip Action:  

Click the flip action button on the action panel, match parameter and object for the action. Herein, we choose "roughness" as the 

object, and position the action button, as shown in below picture. 

Use the same method to add a pair of flip parameter and action of the vertical direction, as shown: 

 

 

 

 

 

3. Test Dynamic Block:  

As you can see, after add flip parameter, if only click flip grip, you can turn the characters to the correct direction. 
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Dynamic Block Creation (Linear Stretch)                                                                                                

For example, during mechanical design, we often need change the position as well as the dimension of the keyway. In this section, 

we will add Linear stretch function for the keyway on the step shaft. 

1. Add Linear Parameter:  

Add linear parameter to object as shown below: 

 

2. Add Stretch Action:  

Click stretch action button on action panel, choose parameter according to prompt and define right grip as key parameter point, as 

shown in below picture. 

 

 

 

 

 

 

Blacken object is the operational object of the action, broken line frame is the stretch frame, objects intersect with stretch frame 

will be stretched, objects which be selected by stretch frame will move. 

3. Test Dynamic Block:  

Exit from block editor, drag stretch grip to stretch the keyway, as shown in below picture. 

 

 

 

 

Dynamic Block Creation (Parameter Value Set)                                                                                                

For mechanical design, we often need stretch the keyway to a certain length. Now, let us see how to realize the accurate stretch. 
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1. Pick Linear Parameter:  

In block editor, pick the linear parameter, then click entry frame which is in the right side of "distance type" on Properties panel, 

there comes one drop-down menu. 

 

 

 

 

 

 

Therein, none is default option, means can stretch optionally. By other two options, you can define maximum and minimum 

number respectively. 

"Increment" means stretch increasingly, Value set appears like below after select increment. 

 

If you choose "list", Value set appears like below picture, dynamic block can only be 

stretched accord with the number in the list. 

 

2. Click Text Frame:  

Which is in the right side of "distance value list". Click this button, it comes "Add distance" dialog box. Add three numbers 

“1”.“1.5”.“2” in the dialogue box, as shown in below picture 
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3. Test Dynamic Block:  

Exit from block editor and stretch the right grip, you will realize several gray lines appear in the right side of keyway, and keyway 

can only be stretch to the gray line position, as shown in below picture. Obviously, by value list, you can define certain numbers of 

the stretch, to realize accurate stretch. 

 

 

 

 

 

Dynamic Block Creation (Symmetrical Stretch)                                                                                                

There is an easy way to realize the two-way stretch which is adding two stretch actions. Though it can realize two-way stretch, the 

action of stretch is independent. The parameter needs some additional setup to realize the two-way symmetrical stretch. 

1. Add Stretch Actions: 

Add two stretch actions for parameter, and select the two grips of the two parameters as the relevant point of each action. 

2. Modify Base Location:  

In the misc, modify the base location from "Start Point" to "Mid Point", like the shown picture below. Save and quit the block editor. 

 

 

 

3. Test Dynamic Block:  

For the convenience of watching the effect, we draw a vertical center line at the middle of the keyway, and then stretch the grip to 

the left side of the keyway or the right side. Like the shown picture below. As the grips moving, two-way symmetrical stretch 

realized. 
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Dynamic Block Creation (Distance Multiplier)                                                                                                

Take step shaft as an example, if we stretch the left part of the step shaft and the keyway still is at the center point of smaller 

diameter shaft after stretching. As the following picture shows: 

 

 

 

 

 

 

Then, we use “Distance Multiplier” property of action to achieve the aim. 

 

1. Add Linear Parameter and Stretch Action for Step Shaft:  

Hide right grip of parameter point, action stretch box is as the following picture, the bolded object is action operation object. 

 

 

 

 

 

 

2. Add Move Action for keyway:  

Select left grip of linear parameter when moving, stretching related parameter points. Move objects of action select the whole 

keyway, as the following picture. 
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3. Modify Distance Multiplier of Action:  

Select Move Action and modify the default value from 1 to 0.5 in the property of distance multiplier, save an exit block editor. 

 

 

 

 

 

 

4. Test Dynamic Block:  

Stretch leftwards grip and with grip moving leftwards, the smaller diameter shaft will appear stretch effect, keyway also will move 

leftwards accordingly, meanwhile, keyway is in the center of smaller diameter shaft of step shaft all the time, as the following 

picture 

 

 

 

 

 

 

 

 

 

 

Although Stretch and Move have a common parameter, but when Distance Multiplier of Move is modified as 0.5, the displacement 

of Move can only stretch 0.5 times of displacement. 

 

Dynamic Block Creation (Chain Action)                                                                                                

If you want to realize symmetric stretch keeping keyway center no change and the length of smaller diameter shaft changes with 

stretch at same time, how will realize that? 
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1. Add Stretch for Step Shaft:  

Add stretch parameter and action for step shaft as the following picture shows. Therein to the bolded objects indicates the 

operation object of action. 

 

 

 

 

Because the follow-up operation will not stretch step shaft by grips of this linear parameter, the grip’s number of linear parameter 

can be modified as “0”. 

2. Add Linear Parameter for Keyways: 

Set the base point position of line parameter as “Center” in order to realize symmetric stretch function. 

 

 

 

 

 

3. Add Stretch Rightwards Action for Keyway: 
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4. Realize Chain Action: 

Select “Distance” linear parameter and modify the chain action of prosperity from “NO” to “Yes” as the following picture shows. 

 

 

 

 

 

 

Add Stretch Leftwards action for keyway as the following picture shows. Special Notes: Do elect “Distance” to linear parameter to 

stretch leftwards operation objects set. This is a necessary procedure of chain operation. 

 

 

 

 

 

 

 

5. Test Dynamic Block:  

After dragging left grip not only the keyway will stretch bi-directionally and symmetrically but also smaller diameter shaft of step 

shaft will stretch automatically. This is chain action. 
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The realization of chain action has two important procedures: First, modify the property value of the parameter that need to happen 

linkage and modify the property of “chain action” from “NO” to “YES”. Second, select the parameter of objects that selected to 

linkage action to set. 

 

Knowing more about dynamic block editor                                                                                                

You use the Block Editor to define and modify the objects and behavior in a block definition. In the Block Editor, you add 

parameters and actions, which define custom properties and dynamic behavior. 

You can access the Block Editor by typing BEDIT command or double-click the block without attribute. You will see The Block 

Editor ribbon interface as below, the black arrows mark stand for parameters, while yellow lighting symbol for action. If users are 

working under classic interface, it will pop-up toolbars. 

Dynamic Block Editor Tool Panels:  

You can uses the tools at Panels to define, edit and modify dynamic block definitions, makes it very convenient and fast. 

Manage: Save or Save as the default block; Create or edit another block. 

Tool: Define, edit or update the block attribute. 

Parameter: You can add parameters for Dynamic Blocks on this panel. 

Action: You can add actions for Dynamic Blocks on this panel. 

Parameter Sets: You can add the parameter set on this panel. 

Visibility: This panel is specially used for Visibility editing. 

Close: It is used to exit the Block Editor. Before exiting, some commands like save or open etc. might not work. 
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Knowing more about parameters in dynamic block editor                                                                                                

Parameters have an appearance similar to dimensions. Parameters also specify positions, distances, and angles for geometry in 

block reference. When you add a parameter to a dynamic block definition, the parameter defines one or more custom properties 

for the block. 

A dynamic block definition must contain at least one 

parameter. When a parameter is added to a dynamic 

block definition, grips associated with key points of the 

parameter are automatically added. You must then add 

an action to the block definition and associate the 

action with a parameter. 

Point Parameter: Defines an X and Y location in the 

drawing. A point parameter can be associated with a move or stretch action. 

Linear Parameter: Shows the distance between two anchor points. Constrains grip movement along a preset angle. A linear 

parameter can be associated with a move, stretch, scale or array action. 

Polar Parameter: Shows the distance between two anchor points and displays an angle value. You can use both grips and the 

Properties palette to change both the distance value and the angle. A polar parameter can be associated with a move, scale, 

stretch, polar stretch, or array action. 

XY Parameter:  Shows the X and Y distances from the base point of the parameter. It can be associated with a move, scale, 

stretch, or array action. 

Rotation Parameter:  Defines an angle. The rotation angle can be in any value, or be defined in a range or a specified value. 

Alignment Parameter: Defines an X and Y location and an angle. An alignment parameter always applies to the entire block and 

needs no action associated with it. An alignment parameter allows the block reference to automatically rotate around a point to 

align with another object in the drawing. An alignment parameter affects the rotation property of the block.  

Flip Parameter:  A flip parameter flips objects. You can associate a flip parameter with a flip action. 

Visibility Parameter: Controls the visibility of objects in the block. A visibility parameter always applies to the entire block and 

needs no action associated with it. In a drawing, you click the grip to display a list of visibility states available for the block 

reference. 

Lookup Parameter: Defines a custom property that you can specify or set to evaluate a value from a list or table you define. It can 

be associated with a single lookup grip. In the block reference, you click the grip to display a list of available values. You can 

associate a lookup parameter with a lookup action. 

Base Point Parameter: Defines a base point for the dynamic block reference relative to the geometry in the block. Cannot be 

associated with any actions, but can belong to an action's selection set. 

Point Parameter: Defines an X and Y location in the drawing. A point parameter can be associated with a move or stretch action. 
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Linear Parameter: Shows the distance between two anchor points. Constrains grip movement along a preset angle. A linear 

parameter can be associated with a move, stretch, scale or array action. 

Polar Parameter: Shows the distance between two anchor points and displays an angle value. You can use both grips and the 

Properties palette to change both the distance value and the angle. A polar parameter can be associated with a move, scale, 

stretch, polar stretch, or array action. 

XY Parameter: Shows the X and Y distances from the base point of the parameter. It can be associated with a move, scale, 

stretch, or array action. 

Rotation Parameter: Defines an angle. The rotation angle can be in any value, or be defined in a range or a specified value. 

Alignment Parameter: Defines an X and Y location and an angle. An alignment parameter always applies to the entire block and 

needs no action associated with it. An alignment parameter allows the block reference to automatically rotate around a point to 

align with another object in the drawing. An alignment parameter affects the rotation property of the block.  

Flip Parameter: A flip parameter flips objects. You can associate a flip parameter with a flip action. 

Visibility Parameter: Controls the visibility of objects in the block. A visibility parameter always applies to the entire block and 

needs no action associated with it. In a drawing, you click the grip to display a list of visibility states available for the block 

reference. 

Lookup Parameter: Defines a custom property that you can specify or set to evaluate a value from a list or table you define. It can 

be associated with a single lookup grip. In the block reference, you click the grip to display a list of available values. You can 

associate a lookup parameter with a lookup action. 

Base Point Parameter: Defines a base point for the dynamic block reference relative to the geometry in the block. Cannot be 

associated with any actions, but can belong to an action's selection set.
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Knowing more about actions in dynamic block editor                                                                                                

Actions define how the geometry of a dynamic block reference will move or change when the custom properties of the block reference 

are manipulated in a drawing. 

 

 

 

 

 

 

 

Move: Move action causes objects to move a specified distance and angle such as a point, a linear, a polar, an XY parameter, etc, 

moves all objects in a selection set in a/any direction. 

Scale: Scale action such as a linear, a polar, an XY parameter, and so on, scales the selected objects in the direction of the parameter. 

Users can manipulate the grips in different way by changing the properties and values in the Properties palette. 

Stretch: Stretch action causes objects to move and stretch a specified distance in a specified location. A stretch action associated 

with a point, a linear, a polar, an XY parameter, etc.  

Polar Stretch: Polar stretch action rotates, moves, and stretches objects a specified angle and distance when the key point on the 

associated polar parameter is changed through a grip or the Properties palette. A polar stretch action can only be applied to a polar 

parameter. 

Rotate: Rotate action is always associated with a rotate parameter. Selected objects can be rotated freely, or the way the grips are 

manipulated is different in the Properties palette.  

Flip: Flip action is always associated with a flip parameter.  

Array: Array action is associated with a linear, a polar, an XY parameter, etc, copies and arrays selected objects in different way.  

Lookup: Lookup action can only be associated with a lookup parameter.  

 

 

How to reference objects to file/URL in GstarCAD? 

In GstarCAD is possible to link an object to another file. So if you needed to see the components specifications or 3D model of a 

certain component from a drawing, you can add hyperlinks to an object. The hyperlinks can be pointed directly to a manufacturer 

website, to a word document that contains the installation procedure, or to excel file that contains product specifications as samples. 
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Adding and Using Hyperlink 

Adding a hyperlink is very easy. Activate hyperlink from menu: Insert> Hyperlink, or from ribbon: Insert> Data panel. 

 

 

 

 

GstarCAD will ask you to select object, then you will see this dialog box: 

 

 

 

 

 

 

 

 

In this example you can add link to specification document in your local computer, or you might want to point it to a file on your server. 

Or a page on website. Not only website link and local files, you can link to layout or saved view in your model. You can also link to 

email address. Maybe you want to link a certain item to vendor contact person for maintenance or something. This can be useful for 

building maintenance purpose. 

 

 

 

 

 

 

How to draw an arc with a specific arc length? 

There are some methods that seem to allow you define length. For example start, center, length. But this is defining the chord length, 

not the arch length. Calculating the angle using simple mathematic calculation, comparing the arch radius and arch length. After you 

get the angle value, then you can draw it. But it is not easy! 
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A better solution is drawing the arch, then modify it using LENGTHEN command. Lengthen command allows you to define the object 

total length, including an arch. Select the total lengthoption, then type the distance you want. 

 

 

 

  

 

 

 

Now if you try to inquiry or see the arc properties, you will see the arch has the exact length I wanted. 

 

 

 

 

 

 

 

 

How to enable object snap to hatch? 

There are several users asking, why they can’t snap to hatch object, the answer is simple, because they did not enable a drafting option 

to snap to hatch object.  
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To activate it, simply use OPTION command. In option dialog box, drafting tab, in object snap options, turn off ignore hatch objects. 

You can also set this option by changing OSOPTIONS system variable. 

 

 

 

 

 

 

 

 

 

 

How to make a multicolored line entity or with embedded text in GstarCAD? 

Although it may sound impossible, you can draw multicolored lines/polylines in GstarCAD. 

MLINE functionality can be used for this. Use the MLSTYLE command to define a new multiline style and define (element properties) 

two line elements, both with the offset equal to 0. Set different colors to them (e.g. green and red). Use different linetypes, e.g. 

DASHED and DASHED2 (you may need to Load them first) - for real-life applications you will probably need to define your own 

linetypes. Save the new Mline style.  

 

 

 

 

 

 

 

http://www.cadforum.cz/cadforum_en/command.asp?cmd=MLSTYLE
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Now use the MLINE command to draw a polyline using this new mlstyle - it has alternating green/red colors! You can use the same 

approach to define even three or more colors. 

 

 

As GstarCAD allows defining complex linetypes containing text, you can even make linetypes (mlines) with embedded text in a 

different color than the line (e.g. line in a BYLAYER color and text always in blue). For this you need to define one complex linetype 

containing text and almost no lines (e.g. only dots) plus an appropriate dashed linetype with spaces for the text. 

 

 

  

  

  

 

 

 

 

 

 

 

 

How can I draw a tangent line off an arc within a polyline? 

You may have noticed that when you go to the ARC mode within the PLINE command, the first and consecutive arcs are tangent to the 

previous segment. To create a tangent line off the last segment, first press L for Line mode, then press a second L for Length.  Pick or 

enter a distance and the segment drawn will be tangent off the last arc. It’s the 2nd L that does the trick. 

 

 

 

 

 

 

 

 

http://www.cadforum.cz/cadforum_en/command.asp?cmd=MLINE
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How can I create a circular wipeout? 

Many CAD users want to create a circular wipeout, as you may or may not know, you cannot create a wipeout using a circle, only a 

closed pline without any arcs. Instead, use the POLYGON command. 

 

1. Enter the command POLYGON, 

2. When prompted to enter the number of sides, enter a value of 36 which will create a closed pline that looks just like a circle. You 

can assign the value of 36 sides for the pline because it looks just like a circle without having too many vertices that make the closed 

pline too “busy” 

 

 

 

 

 

 

 

 

 

 

 

3. Then use of the WIPEOUT command like you normally would, and choose Polyline option, then select the pline created and done! 

Also you can change the wipeout properties via properties window. 
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How to create 2D isometric drawing? 

If you work in plant industry, then you might need to draw isometric drawings. If you use GstarCAD, you may wish you can do it easily. 

It’s not a 3D drawing, but 2D drawing by simply change your drawing orientation. You can do it by using snap, then change its style to 

isometric. 

 

 

Command: SNAP 

Specify snap spacing or [ON/OFF/Aspect/Style/Type] <10.0000>: S 

Enter snap grid style [Standard/Isometric] <S>: I 

Specify vertical spacing <10.0000>: 10 

 

 

 

 

 

 

 

Also you can change your plane by typing ISOPLANE [enter] then select left, top, right.Alternatively, you can use the SNAPSTYL 

command, changing the variable value to 1. You can change your plane by typing ISOPLANE, but it can be done faster by pressing 

“F5″ key. To came back to the default, use the SNAPSTYL command again and change the variable value to 0. 

 

 

 

 

 

 

 

A sample of GstarCAD's geometry calculator 

People often don't know about GstarCAD's built in geometry calculator. While it lacks in interface appeal it more than makes up for it in 

capability. Take the ability to snap to a point between to endpoints. Consider this example where a circle is placed halfway between the 

endpoints of two lines. 

Command: CIRCLE 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 'CAL 

>> Expression: MEE 
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>> Select one endpoint for MEE: 

>> Select another endpoint for MEE: 

The key is when prompted to specify any point, enter 'CAL and type in the expression.  In the case of MEE it knows you want endpoints 

and you don't have to use an object snap when picking.  Also bear in mind that MEE is only one of dozens of expressions available in 

GstarCAD. 

 

 

 

 

 

 

 

 

How do I change Mtext to lower case or upper case? 

You might make a mistake and want to change the text case… either to lower case or upper case. Do you need to re-type it? No way! It 

is easy to do. 

1. Select the word you want to change for. 

2. Right click in the word, select the CHANGE CASE option> Lower case or Upper case from the context menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Alternatively, press [Ctrl] + [Shift] + U to set the text to upper Case OR press [Ctrl] + [Shift] + L to set the text to lower case. 

 

How do I move, rotate, and scale an object at once? 

ALIGN command is often overlooked by many CAD users. Instead of using move, rotate, and scale commands separately, you can do it 

at once using this tool. 

Modify 



 

40 

 

With ALIGN you can move, rotate and scale an object while aligning it with existing geometry or selected points. You can also scale 

and align images. 

Just draw a line to the “known length”, select the two corresponding points on the image and use the scale option to rotate, scale and 

place the image perfectly. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4 SHIFT key combination you might not know 

It is great to know that GstarCAD offers keys combination that helps modify basic objects quickly. Many people don’t realize that using shift 

combination can increase their productivity. Here is a little list that might interest you: 
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1. Hold [shift] + right click. 

This shortcut key combination will display context menu for snap overrides really quickly. Try to hold [shift] then right click. Release, 

then press [E] to activate end point snap. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Hold [shift] for temporary ortho mode 

Holding this key while you draw, will activate temporary ortho mode. Exactly like when you activate ortho mode by pressing [F8]. But 

this is just temporary. 

 

 

 

 

 

 

3. Holding [shift] while chamfering and filleting 

You know what will happen if we hold this shortcut key when we use chamfer or fillet? It will override the distance or radius value, and 

will use 0 (zero) value! Pretty nice. 

4. Holding [shift] while using trim/extend 

When we use trim, sometimes we want to extend other objects to the same reference. You don’t have to finish your trim session, 

and activate extend to do it. Just hold [shift], then trim will be inverted to extend command. This work on the other way when extend 

command is active, it becomes trim! 
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How to modify objects with non-uniform scale? 

Just using a simple tool. In the drawing below, if you notice blue cloud area, you can see that the columns or pillars do not fit in width 

with the long narrow balcony. By the way the columns are block objects.  

 

 

 

 

 

 

 

 

 

 

 

 

Do not worry; there is an effective way to solve this issue. You can use non-uniform scale option for the column. It only scales it on X 

axis, but ignore the scaling on Y axis. How to do this? 

 

1. Type INSERT command and the INSERT dialog box will pop up. 

2. Search the COLUMN block. 

3. Under Scale> uncheck the Uniform Scale option. 

4. Left the X value to 1, and change the Y value a bit, let’s put value 2 as sample. 

5. Click OK button. Just you need to place it correctly and make several copies, done!  
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How to annotate isometric drawings? 

Have you tried to annotate your isometric drawings? How about dimensions and text, is it appear properly? No it’s not. The drawing 

looks isometric, but not the annotations. So how can you create isometric annotations? 

 

Isometric Text 

First, create two text styles within the Text Style dialog box. Use oblique angle 30 deg for one style and -30 deg for the other. 

 

Now try to create text (single or multi line) with different styles and angle combination, then change the rotation to 30 deg or -30 deg. 

It depends on where you want to put it. See next image as reference. 

 

 

 

 

 

 

 

 

 

 

Dimension 
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Isometric Dimension 

What about dimensions? You also have to create two styles within the Dimension Style Manager dialog box. One of the style use 30 

deg text style, and the other one use -30deg. 

 

Now place aligned dimension. Notice that 

the extension lines of the dimension placed 

are not perpendicular as the blue line. Now 

we have to do a little modification. 

Activate DIMEDIT [enter], choose OBLIQUE, 

then give 30 or -30 as oblique angle. Once 

again, depends where your dimension is. 

 

 

 

 

 

Command:  DIMEDIT 

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: O  

Select objects: 1 found 

Select objects: 

Enter obliquing angle (press ENTER for none): -30 

See this image as reference. 

 

 

 

 

 

 

 

 

 

How to set a dimension style to content always blank? 

If users do not want to show dimensions value for a particular reason, they can make the dimension contents permanently blank by 

following the steps below: 

1. Create a new dimension style in the dimension style dialog box. 

2. Go directly to primary units tab, on prefix blank space, type in:  \H 
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3. If you are using a precision unit like: 0,0, you must type \H on suffix as well. 

4. Click OK button and set current your new dimension style. Done, just try it! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Navigate between model and paper space with hyperlinks 

Below is a step-by-step process that helps you quickly navigate between Model space orientations and multiple Layout tabs using 

Saved Views and Hyperlinks (this tip is lengthy, but so worth the effort). 

1. While in a Layout tab, use the VIEW command to save a view name (usually, I would name the view based on whatever the sheet 

number would be, like “A101”) 

 

 

 

 

 

 

 

 

 

 

 

View & Settings 
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2. Then, draw a closed pline around the perimeter of a Viewport (either on Layer “defpoints” or a unique layer set to “no plot”), and 

then use the CHSPACE command to send the pline into Model space through that Viewport. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. With your cursor still within Model space via inside the Viewport, save a new view name to something reflecting what is going on 

within the viewport and including the sheet number (eg. “Plan 1 – A101”), and then bring your cursor back into the Layout 

environment (ie. PSPACE command) 

 

 

4. Enter the command HYPERLINK. 

5. When prompted to “Select Objects”, select the Viewport boundary that you just saved a view in. 
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6. When the “Insert Hyperlink” dialog box appears, click on the “View of this Drawing” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Expand the Model tree by clicking on the “+” symbol, select the view name you just created, and then click the OK button 

 

 

 

 

 

 

 

 

 

 

 

Now, hold down your Ctrl key, and click once on the Viewport boundary with your left mouse button. GstarCAD will then switch to 

Model space and zoom into the area of the saved Model space view that you created earlier and you will also see the closed pline that 

you sent through the Viewport. 

 

 

 

 

 

 

 

 



 

48 

 

Why specific objects in my drawing are shown as boxes? 

Have you ever found that when you open a drawing, you see your texts are missing? You only see them as boxes like below. 

 

 

 

 

 

 

 

 

 

 

This is actually a setting to simplify the drawing appearance. By simplifying the text appearance, you can work with drawing faster. 

Check the trick to turn on the missing text in your drawing. 

 

QTEXT 

The system variable that responsible for this appearance is QTEXTMODE. This system variable is stored in drawing, so it’s drawing 

specific. Not for all drawings. You can turn it on/off by typing QTEXTMODE. Value 1 means it is active and 0 is inactive (default). So 

use it only when you don’t work with text. 
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GstarCAD match properties settings 

Many users already know that we can match object properties using MATCHPROP (or MA for short key in). This tool is very handy for 

you who want to change an object’s properties to copy other objects. But many of us don’t realize that there are some settings that we 

can use in this tool. It allows us to use this tool to match only a specific property. Let’s say you want to copy an object line style. But 

you don’t want to copy its color, layer, and any other properties.  

 

Let’s try to activate this tool. Type MA then hit [enter]. 

You can also use activate this tool from GstarCAD ribbon> home tab> clipboard panel> match properties. 

 

 

 

 

After you activate the tool, pay attention that there is an option to choose settings in the command line. Type S then hit [enter]. 

 

 

 

 

 

 

 

 

You will see property settings dialog box. Uncheck anything that you don’t want to change. Click OK. Now you can copy selective 

properties to your GstarCAD objects! 

 

Move objects together or edit them individually by group tool 

Do you ever need to move or edit objects together but still have the need to edit those same objects individually? GstarCAD can do 

that with GROUPS. 

Tools 
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Groups are different from blocks. With blocks, you can manipulate the block as a whole, and that’s it. With Groups, you can edit the 

object but it won’t change other instances of that group. And you can’t share groups from file to file. Making groups is rather easy.  

1. Start the GROUP command. 

2. Fill out the GROUP NAME field (to name your group) and enter a description. If you don’t enter a description you can always fill 

this out later.  

3. Then hit the NEW button. Select the items you want to group and hit enter. You’re done. You now have a group. 

 

 

 

 

 

So, what can you do with a group? You can GRIP edit the items individually, move/copy/scale the group as a whole. Double clicking 

the text in a group won’t invoke the text editor. You have to start the text editor command then select your text to change it. 

 

 

 

 

Now what else can I do with a group? Open the GROUP Manager (type in GROUP).You will get a list of every group in the file. Pick 

one, and then hit the HIGHLIGHT button. That group will be highlighted in your file making it easier to find. A ZOOM TO feature would 

be nice. You can remove the selectable feature from a group, if you want to (do this to be able to delete a specific item). That will 

remove your ability to copy/rotate/scale/move the group as a whole. You can put it back later if you want to. 

 

 

 

 

 

 

 

http://cadablog.blogspot.com/2008/06/groups-you-gotta-keep-em-seperated.html
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With the Group Manager, you can add or remove items from a group. Click the proper button and then select the items to add/remove 

to/from the group. You can reorder the order in which the groups appear in the manager; you can explode a group, rename it or edit 

the description. 

 

How to copy relevant features from another drawing? 

Users will have the ability to copy relevant drawing features like dimension and text styles, blocks, layers, linetypes and xrefs from 

Drawing A and add it to Drawing B using DESIGNCENTER tool in GstarCAD. 

1. To open DesignCenter, you can either use Ctrl +2, or go to the View tab>Palettes panel>DesignCenter.            

2. Navigate to the drawing containing the layout tab you would like to add to the current drawing.                     

3. Expand the drawing node by clicking the plus sign (+) to display the available content from that drawing which can be brought into 

the current drawing.                                                                                                  

4. For example, click on the Linetype to display the linetypes contained in that drawing.                                                                    

5. Select the linetype you want and drag it into the drawing area! 

 

 

 

 

 

 

 

 

 

 

How to create tool palettes from block libraries? 

If you already have a drawing that you consider as a standard, you may want to use the blocks from that drawing. The easiest way to 

manage the blocks is using tool palette. So do we need to open the drawings, drag and drop each block to the palette? No way!  

You can use design center and create the palettes just with a few clicks!  

1. Open design center, find you file.  

2. Expand the (+) sign, right click on blocks.  

3. Click the option CREATE TOOL PALETTES, then the blocks in that file will be in a palette! 
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Where can I see the command alias list? 

When you use GstarCAD, you’ll want to use it optimally right? You can see the command alias list and customize your own shortcuts 

by accessing edit aliases in ribbon> Manage tab> Customizes Settings panel> Edit Aliases. Or you can access it from 

menu> Tools> Customize>Edit Program Parameters (gcad.pgp) 

 

 

 

 

 

 

 

 

 

 

 

 

This will open your gcad.pgp file in text editor (by default it’s notepad). 
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As you can see, the list of all GstarCAD command aliases by default. So aliases for line is L. When I type L then [enter] will activate the 

line tool. Typing LA [enter] will open the layer manager. Etc. They are very useful shortcuts to work faster! You can edit the command 

aliases and change them to what you want. After you finish, save this file. You might need to restart your GstarCAD after doing your 

modification. Or you can run REINIT to reload your gcad.pgp. 

Updates:  

There is another way to modify command aliases easily. You have to use express tool to do this. 

This tool name isCommand Alias Editor. You can access it from 

menu: Express>Tools>Command Alias Editor. 

 

 

How do I customize command shortcuts easily and faster? 

 

A faster way to invoke a command is customize its shortcut. The CUSTACC command 

allows you to customize, delete or modify existing command shortcuts. To access this 

command go through the menu bar, under tools, select customize and choose Shortcuts 

Customize. After that, the shortcut customize window will pop up. As you can see, there is 

a list of shortcuts command that you can easily modify, delete or even make a new one 

over an existing one. 

If you want to create a new one, just click the New button and the customize command 

window will pop up. Then you can search the command or select one from the command 

list. For example, you can input “command line” and then select the requested command. 

Notice that by selecting the requested command, at the right side of the window, will 

display the command properties. After selecting the command, press the OK button. 
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Then the set shortcuts window will pop up. You can use shortcut key combinations. For example, you can press ctrl and input G. 

 

 

 

 

 

 

 

 

 

If you want to delete a created shortcut command, invoke the command CUSTACC,  select the command and press delete button from 

the Shortcut Customize window. 
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How to select all horizontal or vertical lines in a drawing? 

If you need to select all horizontal or vertical lines within a drawing, this could be a tedious work. It is not easy to select them in quite a 

complex drawing. But you can do it easily if you use QSELECT tool. 

So how to use it to select all vertical lines? Simple. It means they have the same X value, and horizontal lines have the same Y value. 

When you activate quick properties window, change object type to line, properties to Delta X (or Delta Y), change the value to 0. Click 

OK, you are done! 

 

 

 

 

 

 

 

 

 

 

Remember: You can filter the selection further. You can choose only vertical lines on layer 1, or horizontal lines that have red color, 

with a specific length, and so on. 

 

 

 

 

 

 

 

 

 

 

 

 

http://cad-notes.com/2009/10/autocad-quick-select/
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How to use GstarCAD Layer walk? 

Have you ever get confused which created objects are on which layer? When you work with layer standard, you may have dozens or 

even hundreds of layers in your drawing. Finding which one sets to wrong layer can be a tedious work. Here is a tip: 

Type LAYWALK command to activate this tool. Alternatively, you can access it from menu: Format> Layer Tools> Layer Walk. Or 

access it from your ribbon: home tab>layers panel> layer walk. 

 

 

 

 

 

 

 

 

 

With this tool, you can quickly check if your objects are placed correctly in their layer. You can turn off restore on exit if you find the 

one placed in wrong layer and move it. 

 

 

 

 

 

 

 

Layer 

http://autocad.wikia.com/wiki/Layers_Standard
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Hold a layer 

You can show multiple layers by pressing ctrl key then make the selection. Or, if you don’t like pressing ctrl, you can right click then 

select hold selection from context menu. 

 

 

 

 

 

 

Create layer states 

Another interesting thing it can make is layer state. Creating layer state may be a bit tedious, but it is easy using layer walk! Simply 

select all layers you want to turn on. It should be easy because it’s fast and you can quickly see the changes on your screen. Now right 

click, then select save layer state from context menu. Type the layer state name, then you’re done! Very easy, right? 

 

 

 

 

 

 

 

 

 

 

How do I save time converting files layers with Layer translator? 

If you ever have received a set of DWG files from a client and want to clean up the layers according to my drawing standards, how do I 

do it and not take days or having to write code? 

The solution is quite simple, and powerful. Using Layer Translator tool, you can read a specific drawings layers or a DWS (Drawing 

Standards) file and use them as the target then select the drawings you want to translate layers from to your standard layers and map 

them. 

You can access to Layer Translator from by type in LAYTRANS command or by menu> Format> Layer Tools> Layer Translator. 

 

http://cad-notes.com/2009/09/creating-different-drawing-representation/
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For example, you can map and translate same layer name as shown below:  

 

 

 

 

 

 

 

With the layer translator settings, you can setup layer properties to be translated into the assigned layer of your drawing standards that 

you need. 

 

   

 

 

 Force Object Color to BYLAYER: Specifies whether or not every object translated takes on the color assigned to its layer. 

 Force Object Linetype to BYLAYER: Specifies whether or not every object translated takes on the linetype assigned to its layer. 

 Translate Objects in Blocks: Specifies whether or not objects nested within blocks are translated. 

 Write Transaction Log: Specifies whether or not a log file detailing the results of translation is created. If this option is selected, 

a log file is created in the same folder as the translated drawing. The log file is assigned the same name as the translated 

drawing, with a .log file name extension. 

 Show Layer Contents When Selected: Specifies which layers to display in the drawing area. 
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When you are done you will be promoted to save the mapping data to use again in a .DWS (Drawing Standards) file. 

 

 

 

 

 

How do I purge layers that don’t want to be purged? 

Want to clean up you drawings from extra or garbage layers? The obvious way to purge layers is to use the PURGE command but 

sometimes it’s not enough. Purge might need to be run several times. Make sure to select purge nested items. Notice that in the purge 

dialog box you can find items you cannot purge. 

 the active or current layer 

 layers with objects 

 layer 0 

 layer Defpoints (It can be purged if you remove all dimensions) 

 layers in XREFs (xref-dependent layers 

 

Here there are some tips to purge unwanted layers: 

- Layers can exist nested in blocks. They can be used by empty text strings (QTEXTMODE 

can be used to show these) or lines without length or even viewports that have the layer 

frozen. 

- LAYMRG (Layer Merge) or LAYDEL (Layer Delete) might be able to help you either merge the layer to for example layer 0 or if you 

don’t care what’s on the layer delete it.  

LAYWALK is also useful to see what is in each layer and can purge unreferenced layers.  

LAYTRANS can also purge layers. In the Layer Translator, right-click in the Translate From list. Click Purge Layers. 

 

 

 

 

 

 

 



 

60 

 

- To use the filters in the Properties palette (QSelect) can also work but you might need to explode everything several things first. 

 

 

 

 

 

 

 

 

- Another way to generally purge a drawing is to Wblock the entire drawing to a new drawing or use WBLOCK and * for whole drawing 

or you can Wblock selected objects. 

 

 

 

 

 

 

 

- You can also try to isolate the problem by deleting 50% of the drawing, try to purge and then keep repeating it until nothing is left. If 

the layer is still there it might be used by some kind of object that is not purged using the plain purge command. 

- DXF can also help. Save as DXF or use DXFOUT command and open in a text editor and search for the layer to see where it is used. 

 

How to change referenced file layer properties in master file? 

When you work with engineers and architects, they might use your structure drawings as reference in their drawings. The problem is 

each engineer probably has their own standard. You might need to change layer properties for their drawings so it can fit your standard. 

So how you can do that? Do you have to create a copy of the drawing, make necessary changes before you can use it as reference? 

That would defeat the purpose of XREF, isn’t it? 
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Changing layer properties in master file 

Before we start, let’s make a naming convention to avoid confusion: 

We will call the file where you attach the external references as master file. 

We will call the attached reference as referenced file. 

 

1. Try to attach a XREF or external reference.  

2. Open the layer properties manager. This will list the layers from referenced file as well. 

3. Under XREF category you will see all referenced files name. When you select the file name it will only list the layers in that file. 

You should see the layers as FILE NAME | LAYER NAME (2). 

 

 

You can change the properties here. Whatever you do here, will not change the original layer properties. Try to change color, line 

weight, freeze/thaw, etc. 

 

5. Save the master file and try to open the referenced file. You should see it will not change the original file layer properties. The 

properties are specific for master file only. 

 

Understanding Layer 0, ByLayer and ByBlock 

Every time you create a new drawing, you will see a default layer: Layer0. You can’t delete it. 

Then when you define their properties such as color, line weight, etc, you will see ByLayer and ByBlock properties. Most of you might 

already know what ByLayer means. But do you also know what does ByBlock behavior? 

 

 Layer0 is a default GstarCAD layer. You can create geometry in your blocks on it. When you insert those blocks, they will use active 

layer. When you move this block to different layer, the objects in it will use it and ignore Layer 0. 

 When you define object properties (color, line weight, etc) to ByLayer, all of it properties will use the same properties as it’s defined 

in the layers’ properties. 
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 When you create geometries in your block using ByBlock, then you can override its properties after the block has been placed. 

 When you create geometries in your block other than ByLayer or ByBlock, then you can’t override them after your block has been 

placed. 

 

Confused? Let’s create some example to comprehend this better. 

 

1. Open a new file and create two layers, you can give them any name. Set different color and lineweight so we can easily distinguish 

them later. 

 

 

 

 

2. Now we will create 4 objects, in this example I use circle. 

 

 First circle use layer0, color: ByLayer, line weight: ByLayer 

 Second circle use layer0, color: ByBlock, line weight: ByBlock. 

 Third circle use layer0, color: red, line weight: 0.5 (we set this high so can be easier to see). 

 The last one use layer1, color: ByLayer, line weight: ByLayer. 

Create 4 blocks from each of the circle. Now select all those four, and then change their layer to Layer2. You can see block 1 and 2 use 

the properties, but block 3 and 4 still using its own properties. 

 

 

 

 

 

 

3. Now override the color and line weight. Use color green, and line weight 2. You can see that the only block using the overridden 

properties is block no. 2! 
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Only block no.2 using the block properties, because we set it the geometry properties to by block. 

Now freeze Layer1. We can see the block no. 4 disappeared, because the object in it was created on it. 

Unfreeze Layer1, so we can see block no. 4 back. Now freeze layer2. Remember, we have moved all of the blocks to that layer.  

 

What happen?  

All of the blocks disappear, including block no. 4! This block also disappear because the block itself using Layer2. When we freeze 

Layer1, the block is actually still showing. But the geometry inside it will be disappeared. This will be clearer if we have another object 

with different layer in that block. 

Unfreeze Layer2, and then freeze Layer0. None of the blocks disappears! Remember that we created geometry in block 1, 2, and 3 

using Layer0? They will ignore it and use the new properties. 

If you want to understand more about this behavior, try to create more objects in your blocks. Set them to different properties. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

64 

 

 

 

 

 

 

 

How to edit block attributes in Microsoft Excel? 

Block attributes is a great way to store information but if you already have many blocks in your drawing, editing the attributes can be 

tedious and prone to error. It would be easier to edit the attributes in table, isn’t it? 

 

 

 

 

 

 

 

 

Export the attributes data (ATTOUT) 

You can edit the attributes in Microsoft Excel. To do that, first you need to export the data from GstarCAD. You can use ATTOUT 

command. Or you can access it in Express Tools tab> Blocks panel. Export attributes will ask you to define a file name (in .txt format) 

and select objects to export. 

 

 

 

 

 

 

 

 

Express Tools 
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Editing the attributes 

You can edit the file using notepad. But it may not be convenient. It would be more convenient to edit it in Microsoft Excel. 

Furthermore, you can use formula if the attribute should be calculated value. You can open txt file in Excel and edit there. 

 

Open Microsoft Excel, then open file. Change the file type to Text Files or All Files to see your exported file. 

 

 

 

 

 

 

 

 

Click open. You will see import wizard. You can click Next to review the import settings. Or just click finish to accept default settings. 

Usually default settings would be fine. Now you can edit the values. 

DO NOT edit the handle column. It’s the block ID. If you change it, it might not be imported properly. 

 

 

 

 

 

 

 

 

After you finished, save the file. You may see warning because you are working in txt format. Just click yes, because we want to keep it 

in that format. 

Import the attributes data (ATTIN) 

You might already guess the next step. Yes, you can import the value after finish editing. 

You can use import attributes or ATTIN command. Or you can access it in Express Tools tab> Blocks panel. 

Command: ATTIN 

Reading the input file… Done. 11 Block inserts modified. 
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This is very handy if you work with many blocks in your drawing. Editing block attributes in drawing would take a lot of time. 

 

 

 

 

 

 

 

 

 

How to rotate multiple texts at once to readable orientation? 

If you have many texts, mtexts or block attributes in your drawing. And you want see them rotated to different angles. They can be very 

hard to read! To fix text orientation you can use: Rotate text tool. 

Accessing Rotate text tool (TORIENT) 

You can access this tool on Express Tool tab> Text Tools> Rotate Text. If you love command line, simple type TORIENT then press 

[enter]. 

 

 

 

 

 

 

 

Rotating text works! 

After you activate the tool, you can select all texts you want to rotate. Press enter after you finish with the selection. Now you have most 

readable as default option. Just press [enter] if you want this option. 
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Or if you want to define text orientation angle, you can type the angle then press [enter]. Of course, you can click points to define the 

angle too. 

 

See this image. The left image is how the original texts look like. If you choose most readable, then the orientation will be like on the 

right top. It maintains the original angle, but oriented so you can read the texts from bottom or right side of the paper. 

If you type 0, then the result is like on the right bottom. Pretty useful, right? 

  

 

 

How do I create my own linetype? 

GstarCAD default linetypes are usually enough for common purposes. But sometimes it’s just not enough sometimes we need to have 

our own. The problem is creating custom linetype can be difficult to do. But if you have express tools, creating custom linetype can be 

very easy, faster and consume less hardware resources. 

 

First, you can create a simple linetype. Draw one line, and one single line text as shown below. 

 

 

 

 

 

To convert those object in to a custom linetype. 

1. Access from Menu: Express>Tools>Make Linetype. Or you can type MKLTYPE command. 

2. Type you line type file name, then click save. This file name is what you’ll see when you load the .lin file in windows dialog box. 

 

 

 

http://lynn.blogs.com/lynn_allens_blog/2005/06/loading_the_exp.html


 

68 

 

 

3. Type your linetype name, then press [enter]. This line type name is what you’ll see in the name list. 

4. Type your line type description (optional), then press [enter]. This description should be able to give you a brief description about 

this line type. 

5. Specify starting point and end point. In this example, I choose left end point of the line as start point. And somewhere slightly on the 

right of the text. 

6. Select objects. Select them both, then press [enter]. 

 

 

 

 

 

 

 

 

 

 

There you go. Change the linetype properties, and try to draw lines, arc, or any other objects. 

 

 

 

 

 

 

 

 

 

How do I use filter selection? 

We have discussed about using Quick Select before. But there is one more utility that you can use, not as pretty as QSELECT. FILTER 

command offers a dialog box that might also scary when you first see it. But after you use it for a while, you may don’t want to use 

QSELECT anymore. 

The advantages of using FILTER are: 

1. You can set multiple conditional filters at once. QSELECT only allow you to apply one conditional filter at a time. 

Then you need to apply another filter to your selection. 

2. You can save the filter setting and use it again later. Let’s see how it works. 

http://cad-notes.com/2009/10/autocad-quick-select/
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Using Conditional 

You can open your drawing. Type FILTER then [enter]. Filter dialog box is loaded. 

Now if you want to select all objects that the color defined other than by layer. You can simply add this line. 

**Begin NOT 

Color             = 256 - By Layer 

**End NOT 

 

 

   

 

 

 

 

 

 

 

 

 

You can do this to select all objects that’s not using ‘ByLayer’ color, and change them to ByLayer. 

You can add more conditional for complex objects. Let’s say you want to quickly select all circle and lines, and the color must be red. 

Then the conditional lines in the filter must be: 

 

**Begin AND 

**Begin OR 

Object           = Circle 

Object           = Line 

**End OR 

Color             = 1 - Red 

**End AND 

 

Saving Filter 

The beauty of filter is it can be saved. If you defined many conditional filters, then it would be ridiculous if you have to set it every time 

you want to use it. Type the filter name in Named Filters group and click save as. 

 

 

 

 

 

 

 

 

 

 



 

70 

 

Now, after you save some filters, you can quickly select your objects with selective properties in just a few clicks! 

 

How can I arrange objects horizontal or vertically? 

Users are tired arranging a bunch of objects manually by using move command. In GstarCAD you can use ARRANGETOOL command 

to quickly adjust the arrangement (vertically or horizontally) of multiple selected objects such as rectangles, circles, splines, lines, 

plines, blocks even texts. This tool has different arrangement methods and also includes spacing option for column and row. This 

arrangement options can be combined as well. You can access from Menu: Express Tools> Modify> Arrange Tool. 

For example, ArrangeTool makes the bearings evenly distributed in the shaft. 

Another example, we can apply this tool for arrange the part numbers distribution over the leader lines. Notice that the objects to be 

selected are Mtext and will be distributed according to the top object level as a reference. After started the command, a prompt 

message will display > Please select the object to arrange: 

 

 

 

 

 

 

 

 

Then select the part numbers. After select the part numbers, the arrange tool window will pop up, select the option: Specify spacing 

and then check or select the option: Top vertical arrangement. See the result below: 
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Let's see another interesting example applied in an architectural detail drawing. We will arrange the stairs distribution and distance 

faster than ever, avoiding again to use the move command. See the picture below: 

 

 

Notice that the objects to be selected are blocks and the horizontal distribution value is 54mm from each other. 

After starting Arrangetool, a prompt message will be displayed > Please select the object to arrange: 

Then select the stairs. After selecting the stairs, the arrange tool window will pop up, select the option: Specify spacing and then check 

or select the option: Left horizontal arrangement. See the result below: 
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After this, under Specify Spacing there is a title (Column), beside it input the value 54 and then see the result below: 
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How can I align objects horizontal or vertically? 

Align selected objects to a reference coordinate direction is time consuming if you use move command. In GstarCAD you can use 

ALIGNTOOL that allows align selected objects such as: rectangle, circle, line, spline, arc, pline, block and even 3D model objects 

along the X or Y axis coordinates. This tool has different alignment methods, including an offset option for each axis and can be 

combined as well. You can access from Menu: Express Tools> Modify> Align Tool. 

We can apply this tool in a complex drawing with full objects to be aligned as shown in the picture below: 

 

 

 

 

 

 

 

 

 

 

 

As an example, we will put this tool in action. We can apply this tool to align a high quantity of objects (columns) in the correct place 

in this complex drawing as shown in the picture below: 
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Please note that the columns are not aligned at same position to each other and these are independent blocks. 

 In this case, we will perform Top object Y axis and specified object alignment. Execute ALIGNTOOL command, a prompt message will 

be displayed > Please select the object to align: 

Then select the objects (columns) in any order you want: 

 

After you have selected the objects, the Align tool settings window will pop up: first we have to check the option Top object under Y 

axis alignment. After check this option the objects (columns) will be aligned at same level: 
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 After the objects have been aligned, we have to select the option specified object under Align to. Then select the object (blue line) 

where we want to align and place the objects. Finally you will get a faster result performing this operation: 

 

 

 

 

 

 

 

How do I do object copies along uniform/non-uniform path? 

Users know that array command cannot make object copies along non-uniform path. In GstarCAD, unlike array capabilities, 

LAYOUTBYPATH tool, distributes object copies along a path (uniform/non-uniform) with a variety of array options like: random, 

division and measure, and array in different directions along the path. You can access from Menu: Express Tools> Modify> Layout by 

Path. 

For example, we can apply this tool to array an 

object (block) through a non-uniform path 

(pline) as shown below: 

 

 

 

 

 

 

 

 

After starting LAYOUTBYPATH command, follow the steps below: 

1. Please select the object to array: Select the object (block) 

2. Please specify the base point: You can specify the base point as center of the object. 

3. Specify the object’s direction along the curve<Y axis of WCS>: You can do click up/down the path. 

4. Please select the curve: Then select the red spline as a path. 

5. Specify select along which side of the curve <left side or forward direction>: you have to specify the side, on which the object will 

be arrayed. For example, you can specify the left side of the path. 
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6. Select the method Random (R) / Division (F) / Measure (D): 

Random: Arrays selected object along the path on a specified point according to user’s need.  

Division: Arrays selected object automatically along the path by inputting the number of objects.  

Measure: Arrays the selected object automatically along the path by inputting the distance value.  

For example, if we do not know the distance between objects but we know the objects quantity, we can select the option Division: 

After selecting the option, a message will be displayed:  

Enter the number: You can enter the value 11 

After entering the value, a prompt message will be displayed:  

Pick a point on the curve as start point (Distribute from the end curve when selection is empty): Then pick the object center point. See 

the result below: 

 

 

 

 

 

 

 

 

 

 

 

How to get area sum result from closed objects in few clicks? 

Compared with AREA command, AREASUM tools is more flexible and powerful. When using the traditional area command, users 

usually need to redraw the boundary of the region, or convert the boundary into a single object, and then get the area of the closed 

region. 

When the boundary is not a single object, AREASUM tool can automatically search the boundary of a complex graphic. After selecting 

multiple closed regions, the command line will add the current region value and area sum sequence faster in real time. You can access 

it from Menu: Express tools>Modify>Areasum. 

For example, if you finish sketching the layout below, that belongs a tennis center at scale 1:1. Now you want to know the area of the 

Gardens surrounding, the existing courts and the indoor court expansion in few clicks. Just executed AREASUM command.   
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After started the command, you have to pick an internal point(s) in the closed region(s) to see the area result. For example, if you want 

to know the area sum of existing courts including the indoor court expansion, just pick and internal point of each closed objet. After 

picking points, the command line will show up in real time the region value sequence and area sum in (mm2): 
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How to change plotter when publishing? 

Let’s say one day your plotter is broken and you need to publish to new plotter. Or you need to plot it on other office that has different 

type of plotter. Your previous setup will not work. Do you have to modify page setup for all files all over again? Of course not! Let’s see 

some workaround you can do. 

Using DWF 

DWF (or DWFx) is not only for design review purpose. You can consider to publish your drawing to DWF first, then plot it to your 

plotter.DWF format is device independent. You can send and plot it anywhere. If the system can recognize the plotter, you can plot it 

there. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Other independent format you can consider is PDF. PDF is a standard format; almost every computer (including tablets and cell phone) 

can open it. 

Change the format in publish dialog 

If you are not convinced to use intermediate format like DWF or PDF, of course you can change the plotter in publish dialog. You can 

create a new page setup in a drawing. You can create it in a new file or existing file that you want to publish. You only have to do this 

once. Before you do this, you need to have the plotter driver installed. Now when you get back to publish dialog box, you can select all 

sheets in the dialog. Click the first sheet on the list, hold SHIFT then click the last sheet. 

Output 

http://en.wikipedia.org/wiki/Design_Web_Format
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Now you can click the page setup field and choose the new one that you have created. If you created it on a file that’s not in the list, 

choose import. You need to import the page setup first. 

 

How to get high resolution Image from GstarCAD? 

Do you need to create a high resolution image from lines, arcs and other objects in your drawing? No, this is not about rendering. Just 

you can just plot your model/layout. 

Try to open your plot dialog box. You can see a plotter namedPublishToWebJPG.pc3. Use it, you will get a JPG image with fair quality.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://cad-notes.com/2009/07/autocad-and-photorealistic-rendering/
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JPEG probably is the most popular image format for presentation. But if it’s still not good enough… How about BMP, TIFF, or TGA? 

You can add more plotters for those file types. Under Printer/Plotter, you will see the Add Plotter option. Click to open it. This will bring 

you to a wizard window, follow the steps: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click next at the first page. 

2. On the next page, select My Computer. Then click next.  

 

 

 

 

 

 

 

 

 

 

3. On the next page, you can see a list of manufacturers, and the models. We want to add TIF this time.  

4. Select Raster File Formats as manufacturers. Then select TIF option as plotter model. 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/BMP_file_format
http://en.wikipedia.org/wiki/Tagged_Image_File_Format
http://en.wikipedia.org/wiki/Truevision_TGA
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You can also select BMP if you like. Now, you can simply click next and finish through the rest of this wizard. Open your GstaCAD, 

open plot dialog box. You should see your new plotter there! 

Use them to create your image. You should be able to get high quality image from your drawings. 

 

 

 

 

 

 

 

 

 

 

With page setup win (save) money 

Setting up drawing to plot is like an artist making a reproduction of a painting; the two paintings will look very similar, but they’ll never 

look exactly the same. This is much like plotting in GstarCAD; you’ll probably find the right combination to correctly plot drawing 

layout 1, but reproducing those settings for layout 2 and so on... will likely be a shot in the dark. Even if you do manage to perfectly 

reproduce those settings for subsequent sheets or layouts – how much time did you waste? 

 

Instead of manually configuring the PLOT command for each drawing, you can use Named Page Setups to change the same settings 

for your drawing layout 1, 2, 3, and so on. 
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Below you can see, I’ve configured a Named Page Setup that uses the DWFx ePlot plotter, an ARCH expand D page size, and the 

gcad.ctb plot style table. Instead of manually changing these on each of my drawing sheets (Layout tabs). 

 

 

 

 

 

 

 

 

 

 

 

 

I’m only going to change one setting for each Layout – the Page Setup. Here’s how: 

1. Set the Layout tab you want to apply a Page Setup to current. In this example I’m going to set my Sheet 1 layout tab current so I can 

apply the ARC D PAGE SETUP. 

2. Right-click on a layout tab and choose Page Setup Manager. 

3. Select the Page Setup you want to apply (Arch D in this example), and click Set Current. Your layout tab will immediately update to 

reflect the settings stored within your Page Setup (Arch D in the example). 
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Not only do Named Page Setups saved you time configuring each layout tab to plot correctly; they prevent Sheet 1 plotting different 

from Sheet 2 because someone accidentally assigned the ARCH D (36.00 x 24.00 Inches) page size to one sheet and the ARCH 

expand D (36.00 x 24.00 Inches) to the other. For such a small feature, the standardization benefits can be far-reaching. 
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What happened to my PLOT/FILE dialog box? 

You may occasionally find yourself in a situation where the NEW, OPEN, and SAVE commands do not provide a dialog. Simply enter 

FILEDIA at the command prompt and enter a value of 1. If you attempt to PLOT and fail to get a dialog, simply enter ` at the command 

prompt and enter a value of 1. 

Using file dialog at prompts 

Sometimes settings (such as FILEDIA) can cause certain routines to ask for a file name at the command prompt. In these cases you 

can enter the tilde ~ character followed by enter to bring up the file selection dialog. 

Ignoring object snap elevations 

A frequent problem in objects snaps is the inheritance of the Z value when snapping to a point. GstarCAD addresses this problem with 

OSNAPZ system variable. If set to 0, osnap uses the z-value of the snapped point. If set to 1, it uses the x+y of the snapped point and 

the current value of the ELEVATION system variable. Also note that when creating lightweight polylines, the elevation of the first snap 

will determine the elevation. After that, any snap to other elevations will be ignored. 

What is OFFSETGAPTYPE variable? 

This system variable can have a drastic effect on the appearance of offsets. It’s stored in the registry so it affects all drawings. The 

initial value is 0. 

 0  Extends the segments to fill the gap (the old way) 

 1  Fills the gaps with a filleted arc segment (the radius of the arc segment is equal to the offset distance) 

 2  Fills the gaps with a chamfered line segment 

What is TREEDEPTH variable? 

Users with HUGE drawings may want to consider changing the value of the TREEDEPTH variable. It controls the GstarCAD Tree Spatial 

Index, which specifies the number of times the tree-structured spatial index may divide into branches. Setting the value to -3020 

flattens the Z index giving you more granular nodes in the XY which yields faster object selection. It has no effect on the elevations of 

your objects. 

What is PELLIPSE variable? 

If you want the ellipse command to create polylines instead of the true mathematical ellipses, set the PELLIPSE variable to 1. 

System Variables 
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What is SKPOLY variable? 

By default, the SKETCH command creates a collection of line objects. To create polylines instead, set the SKPOLY variable to 1. 

List system Variable 

To check the status of certain system variables, you can use the SETVAR command. After issuing the command, type? to begin the list, 

then apply an optional filter. For example entering DIM* will show all the dimension variables. 

Options to simplify drawing appearances 

Personally, I found that speeding up the whole system and optimizing GstarCAD are the better ways to make it work lighter and faster. 

However, you are probably curious if there are options to simplify drawing appearance. 

FILLMODE 

FILLMODE is very useful for drawings with hatches and solid fills. If you feel hatches degrade your computer performance, you can 

change FILLMODE to 0. This variable is also stored in drawing. 

RTDISPLAY 

If you embed or reference images in your drawing, you can feel that panning and zooming are slow. Especially if the images are high 

resolutions and you have many of them in drawing. 

You can change RTDISPLAY to 0. By default, the value is 0. But probably you or your coworker turned it on before to see the image 

when navigating drawing. This value is also stored in registry. 

MAXACTVP 

This is for you who need to work in layout with many viewports. You can set maximum visible viewport contents. So if you have issue 

with performance, you can set it to low number. It will not affect your plot result.  

Startup system Variable 

This system variable toggles on/off the Startup dialog box to help users to setup drawing templates settings. Using this dialog box is 

safer. It will make them aware to select a template before actually start to draw. You can set this startup dialog box to open everytime 

when you start GstarCAD, Just type STARTUP [enter] then type 1 as new value then [enter]. You can also choose not to open new file 

or dialog box. You can set STARTUP system variable to 2. 

 

 

 

 

http://cad-notes.com/2012/12/speed-up-autocad-optimize-computer/
http://cad-notes.com/2012/12/speed-up-autocad-configuration/
http://cad-notes.com/2011/04/autocad-2012-option-to-start-without-opening-file/
http://cad-notes.com/2011/04/autocad-2012-option-to-start-without-opening-file/
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